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1. PRECAUCIONES 

1.1 ADVERTENCIA IMPORTANTE 

 

El símbolo del relámpago con una flecha en la punta y dentro de un triángulo 
equilátero, tiene el propósito de alertar al usuario de la presencia de un 
voltaje peligroso y sin aislar dentro del aparato, y de una magnitud tal que 
puede constituir riesgo de descarga eléctrica para las personas. 

El símbolo de exclamación dentro de un triángulo equilátero tiene el propósito 
de alertar al usuario de la presencia de instrucciones importantes sobre la 
operación y mantenimiento en la información que viene con el producto. 

ADVERTENCIA (Si se aplica): Los terminales marcados con el símbolo “ ”pueden ser 
de suficiente magnitud como para constituir un riesgo de descarga eléctrica. El cableado 
externo conectado a los terminales requiere ser instalado por personal cualificado o el uso 
de cables ya confeccionados. 

ADVERTENCIA: para prevenir choques eléctricos o riesgo de incendios, no exponer este 
equipo a la lluvia o la humedad. 

ADVERTENCIA: Aparato con construcción de tipo Clase I debe ser conectado a través 
de un enchufe con protección de tierra. 

ADVERTENCIA: Este producto no ha de ser desechado bajo ningún concepto 
como residuo urbano no seleccionado. Acuda al centro de tratamiento de residuos 
eléctricos y electrónicos más cercano. 

Este equipo ha sido testado y se ha comprobado que cumple con los límites de 
un dispositivo digital de Clase A, de acuerdo con la sección 15 de las normas de 

la FCC. Estos límites están diseñados para proporcionar una protección razonable contra 
las interferencias perjudiciales cuando el equipo se utiliza en un entorno comercial. Este 
equipo genera, utiliza y puede irradiar energía de radiofrecuencia y, si no se instala y utiliza 
de acuerdo con el manual de instrucciones, puede causar interferencias perjudiciales en 
las comunicaciones por radio. El funcionamiento de este equipo en una zona residencial 
puede causar interferencias perjudiciales, en cuyo caso el usuario deberá corregir las 
interferencias a su cargo.  
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1.2 INSTRUCCIONES IMPORTANTES DE SEGURIDAD 

1. Lea estas instrucciones. 
2. Guarde estas instrucciones. 
3. Preste atención a todas las 

advertencias.  
4. Siga todas las instrucciones. 
5. No utilice este aparato cerca del agua. 
6. Límpielo solamente con un paño seco. 
7. No bloquee ninguna abertura para 

ventilación. Instálelo de acuerdo con 
las instrucciones del fabricante.  

8. No lo instale cerca de fuentes de calor 
como radiadores, estufas u otros 
aparatos que produzcan calor, 
incluidos amplificadores.  

9. No elimine el propósito de seguridad 
del cable de corriente polarizado o 
con conexión de tierra. Un cable 
polarizado tiene dos bornes, uno más 
ancho que el otro. Un enchufe con 
conexión a tierra tiene dos bornes y 
un tercer borne conectado a tierra. 
Este tercer borne está previsto para 
su seguridad. Si el cable 
proporcionado no entra en su 
enchufe, consulte con un técnico 
electricista para reemplazar ese 
enchufe obsoleto. 

10. Proteja el cable eléctrico de ser 
aplastado, en especial en la zona de 
los conectores, los receptáculos de 
los mismos y en el punto en el que el 
cable sale del aparato.  

11. Utilice solamente los accesorios 
especificados por el fabricante. 

12. Desconecte el aparato durante las 
tormentas eléctricas o cuando no lo 
vaya a usar durante periodos largos de 
tiempo. 

13. Para cualquier reparación, póngase en 
contacto con un servicio técnico 
cualificado. La reparación es necesaria 
cuando el aparato no funciona con 
normalidad o ha sido dañado por 
cualquier motivo, ya sea porque el 
cable o el enchufe estén dañados, 
porque se hayan derramado líquidos o 
hayan caído objetos dentro del aparato, 
o porque el aparato haya sido expuesto 
a la lluvia o se haya caído. 

14. Desconexión de la red: apagando el 
interruptor de POWER todas las 
funciones e indicadores del 
amplificador se pararán, pero la 
completa desconexión del aparato se 
consigue desconectando el cable de 
red de su conector. Por esta razón, éste 
siempre debe tener fácil acceso.  

15. El equipo se conecta a un enchufe con 
protección de tierra a través del cable 
de alimentación.  

16. Parte del etiquetaje del producto está 
ubicado en la base del mismo. 

17. Este aparato no debe ser expuesto a 
goteo o salpicaduras ni tampoco debe 
colocarse ningún elemento lleno de 
agua, tales como jarrones encima del 
aparato.

1.3 LIMPIEZA 
Para limpiar el aparato, utilice únicamente un paño suave y seco o ligeramente 

humedecido con agua y un detergente líquido neutro, luego séquelo con un paño 
limpio. Asegúrese de que nunca entre agua en el aparato a través de ningún orificio. 
No utilice nunca alcohol, bencina, disolventes o sustancias abrasivas. 

NEEC AUDIO BARCELONA, S.L. declina cualquier responsabilidad por los daños que 
puedan ocasionarse a personas, animales u objetos por el no cumplimiento de las 
advertencias anteriores.   
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¡Le agradecemos la confianza que ha depositado en nosotros al 
elegir nuestro equipo Ecler VEO-XCTRLG2! 

 
Para conseguir la máxima operatividad y rendimiento es MUY IMPORTANTE, antes de 
su conexión, leer detenidamente y tener muy presentes las consideraciones que en este 
manual se especifican. 

Para garantizar un funcionamiento óptimo de este aparato recomendamos que su 
mantenimiento sea llevado a cabo por nuestros Servicios Técnicos autorizados. 

Todos los productos ECLER disponen de garantía, por favor consulte en 
www.ecler.com o en la tarjeta de garantía incluida con este aparato para conocer el 
periodo de validez y sus condiciones. 

2. CONTENIDO DE LA CAJA 

• 1 x controlador de vídeo sobre IP. 

• 1 x receptor IR de 20 kHz-60 kHz de 12 V. 

• 1 x conector Euroblock de 3 clavijas.  

• 1 x conector Euroblock de 6 clavijas.  

• 2 x orejetas de montaje. 

• 4 x tornillos de máquina (KM3*6). 

• 1 x adaptador de potencia con bloqueo de 12 V/1 A. 

• 1 x Guía de ayuda para los primeros pasos. 

• 1 x tarjeta de garantía. 

3. DESCRIPCIÓN y CARACTERÍSTICAS 

VEO-XCTRLG2 es un módulo controlador que permite al usuario gestionar y operar VEO-
XTI1CG2 y VEO-XRI1CG2 en grandes sistemas multipunto a multipunto. Tiene dos 
puertos LAN, permitiendo de este modo la recepción de redes independientes de control 
y vídeo. VEO-XCTRLG2 ofrece una interfaz web exclusiva con asistente de configuración, 
control de matriz, creación y funcionamiento inteligente de videowall, selección de fuentes 
mediante la funcionalidad intuitiva de arrastrar y soltar, previsualización de vídeo y 
comandos de control TCP y RS-232 y también admite la función POE, que lo convierten 
en una avanzada herramienta de gestión para todo tipo de instalaciones AV sobre IP. 

 

https://www.ecler.com/es/soporte-y-comunidad/condiciones-de-garantia/
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3.1 CARACTERÍSTICAS PRINCIPALES 

• Creación de proyectos, control y gestión del sistema de forma fácil e intuitiva. 

• Asistente de configuración para asignar fácilmente dispositivos a un proyecto, con 
configuraciones automáticas de DHCP y de IP manuales. 

• Seguridad HTTPS, SSH, SFTP compatible. 

• Interfaz de control WebGUI incorporada, compatible con la funcionalidad intuitiva de 
arrastrar y soltar. 

• Admite previsualización de imágenes. 

• Admite vídeo, audio, RS-232, control y gestión del sistema distribuido. 

• Dos puertos LAN exclusivos para redes de control y vídeo independientes. 

• Admite control de puertos TCP y RS-232 y control centralizado de terceros. 

• Múltiples circuitos de protección. Diseño ESD y protección contra descargas. 

• Diseño de sistema fiable, que garantiza un trabajo seguro y estable 7*24 horas. 

• Funcionalidad PoE. 
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4. INSTALACIÓN y CONEXIONES 

4.1 MONTAJE EN BASTIDOR 

Este producto puede montarse en un bastidor estándar. 

 

1. Apile dos productos uno encima del otro. A continuación, utilice los tornillos 
incluidos para fijar dos orejetas de montaje 1U en los productos. 

 

 
 

 

2. Coloque dos pares de productos juntos utilizando los tornillos suministrados. 

 

 
 

 

3. Fije tornillos entre cada par para montar los cuatro productos juntos. 
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4.2 DIAGRAMA DE CONEXIÓN 

En una configuración típica, los dispositivos se conectan de la siguiente manera: 

 
Cuando el conmutador de red no es compatible con PoE, entonces VEO-XTI1CG2, 

VEO-XRI1CG2 y VEO-XCTRLG2 deberían ser alimentados por el adaptador de potencia 
de DC incluido. 

4.3 REQUISITOS Y CONFIGURACIÓN DE LA RED 

VEO-XCTRLG2 no está limitado a ciertas marcas de hardware de red, pero la red debe 
admitir las siguientes características: 

• Tipo de conmutador de red gestionado de capa 3. 
• Permite y es compatible con el IGMP snooping y el filtrado de multidifusión 

adecuado. 

Para evitar fallos de funcionamiento, interferencias o caídas en el rendimiento de 
la señal debido a los requisitos de ancho de banda de otros productos de red o al diseño 
de la red, se recomienda encarecidamente consultar con el personal informático de la 
red elegida cómo configurar correctamente los productos multidifusión conectados al 
conmutador de red local. 

Una de las ventajas en el uso de VEO-XCTRLG2 es la posibilidad de separar la Red 
de Vídeo de la Red de Control. De este modo, el tráfico de multidifusión coherente 
generado por los extensores de vídeo sobre IP puede aislarse del tráfico de control 
generado por el sistema de control integrado o por terceros. Podemos pensar en el VEO-
XCTRLG2 como en una pasarela entre la red de control y la red de vídeo. 
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4.3.1 CONEXIÓN Y AJUSTES DE LA WEB 

La dirección IP por defecto del VEO-XCTRLG2 para su puerto de control es 
192.168.0.225 si no hay un servidor DHCP en el sistema. 

Una vez conectado un VEO-XCTRLG2 a una red con otros VEO-XTI1CG2 y VEO-
XRI1CG2, el controlador actuará como gestor de la red y asignará automáticamente 
direcciones a los distintos dispositivos. 

4.4 CONFIGURACIÓN MEDIANTE LA INTERFAZ WEB 

VEO-XCTRLG2 se puede configurar a través de su propia interfaz web incorporada a la 
que se puede acceder a través de los dos métodos siguientes: 

• escribiendo la dirección IP elegida o la dirección IP por defecto del dispositivo 
(192.168.0.225 si no se utiliza servidor DHCP) en la pestaña de búsqueda del 
navegador web;  

• escribiendo la URL «controller.local» (esta etiqueta puede personalizarse. Para 
obtener más detalles, consulte el capítulo «Ajustes del controlador». 

 

 

 

Las credenciales por defecto para iniciar sesión son:  

• Username (Nombre de usuario): admin 

• Password (Contraseña): 1234 
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4.4.1 ASISTENTE DE CONFIGURACIÓN 

Una vez iniciada la sesión, si no existe ningún proyecto, aparecerá este mensaje para 
ayudar al usuario a configurar el sistema mediante el procedimiento del asistente. 

 

A continuación, haga clic en «Next» (Siguiente) para avanzar hasta la página siguiente. 

Si el sistema ya se ha configurado previamente, al hacer clic en «Close» (Cerrar), el 
usuario accederá directamente a la página de control del sistema. 

4.4.1.1 GESTIONADO AUTOMÁTICAMENTE POR LA CAJA DEL CONTROLADOR 

Seleccione esta opción «Automatically managed by Controller Box» y, una vez 
seleccionados los ajustes de gestión de direcciones IP, el controlador procederá a buscar 
dispositivos en la red de VÍDEO. 

 

A continuación, haga clic en «Next» (Siguiente) para avanzar hasta la página siguiente. 
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Entonces será posible decidir si se añaden todos los dispositivos conectados al nuevo 
proyecto (instalación totalmente nueva) o si se añaden de forma selectiva en caso de 
cambios en un sistema existente. 

1. Si selecciona «Automatically add Encoders and Decoders to Project» (Añadir 
automáticamente codificadores y decodificadores al proyecto) y hace clic en el 
botón «Explorar», entrará en la página del proyecto. 

 

Todos los dispositivos conectados aparecerán en la lista de dispositivos actuales. 

A continuación, haga clic en «Stop Scan & Auto Assign» (Detener exploración y 
asignación automática) para detener la búsqueda. 

 

2. Si selecciona «List all discovered Encoders and Decoders» (Enumerar todos los 
codificadores y decodificadores descubiertos) en las ventanas del asistente y hace 
clic en el botón «Scan» (Explorar) para acceder a la página del proyecto, todos los 
dispositivos conectados aparecerán en la lista de dispositivos sin asignar.  
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Haga clic en «Stop Scan» (Detener exploración) para detener la búsqueda. A 
continuación, los botones «Add All» (Añadir todos) y «Add» (Añadir) situados 
detrás de los transmisores o receptores no asignados y estos pasarán a estar 
operativos. 

En este momento, puede hacer clic en el botón «Add» (Añadir)  situado detrás de 
cada transmisor o receptor no registrado para añadir el dispositivo al proyecto de 
uno en uno o hacer clic en el botón «Add All» (Añadir todos) para añadir todos los 
transmisores o receptores al proyecto.  

Los transmisores y receptores que se hayan añadido al proyecto aparecerán en la 
lista de dispositivos actuales. 

4.4.1.2 MODO DHCP 

El procedimiento es idéntico al anterior, con la única diferencia de que en este caso las 
direcciones IP son asignadas por un servidor DHCP. 

 

 

No será necesario configurar los ajustes del puerto LAN de vídeo de la caja del 
controlador del VEO-XCTRLG2 en modo automático o DHCP, ya que el controlador los 
configurará automáticamente.  
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4.4.1.3 MODO IP ESTÁTICA MEDIANTE AJUSTES MANUALES 

1. Seleccione la opción «Static IP Mode by manual settings» para introducir 
manualmente la dirección IP. 

 
2. Pulse «Next» (Siguiente) y, a continuación, establezca manualmente la dirección IP, 

la máscara de subred y la pasarela de la LAN de vídeo y entonces pulse Siguiente. 

 

Es especialmente recomendable utilizar un dominio de red IP diferente del 
puerto LAN de control. 

3. Cuando el progreso alcance el 100 %, introduzca la interfaz tal y como se muestra 
en la figura siguiente.  

En esta interfaz, puede establecer el rango de direcciones IP de los transmisores y 
receptores. Una vez completada la configuración, haga clic en el botón «Next» 
(Siguiente) y el resto de los pasos son los mismos que en el primer modo 
«Gestionado automáticamente por la caja del controlador».  
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5. PUESTA EN MARCHA y FUNCIONAMIENTO 

5.1 FUNCIONES Y OPERACIÓN DE LA WEB 

Una vez configurado el VEO-XCTRLG2 y asignados los dispositivos VEO-XTI1CG2 y VEO-
XRI1CG2 conectados a la red a un proyecto determinado, los siguientes menús de la 
página de ajustes de la web permitirán al usuario gestionar y operar diferentes 
aspectos y funcionalidades relativos a la operación del transmisor y receptor tal y como 
se explica en los siguientes capítulos. 

5.1.1 VISTA PREVIA 

En esta página, el usuario puede seleccionar y previsualizar el contenido de vídeo de un 
determinado transmisor o receptor colocado en el sistema haciendo clic en la lista 
desplegable de la derecha y eligiendo el dispositivo que desea visualizar. 

 

5.1.2 CONTROL DE MATRIZ 

1. Encoders (Codificadores): Muestra todos los transmisores actuales. El texto de la 
figura es el nombre del dispositivo.  

2. Decoders (Decodificadores): Muestra todos los receptores actuales. El texto de la 
primera línea es el nombre del receptor, y el texto de la segunda línea se refiere al 
transmisor de donde procede el recurso de señal. 

 

Si hay una imagen en un transmisor, significa que se puede arrastrar el codificador. 
Como se muestra en la figura anterior, si se arrastra un codificador al lugar donde señala 
la flecha roja, todos los receptores compartirán el mismo recurso de señal de este 
transmisor; si se arrastra un transmisor al lugar donde señala la flecha azul, sólo el 
receptor indicado podrá recibir señales de este transmisor. 

Si un transmisor muestra «No Signal» (Sin señal), significa que no puede ser 
arrastrado.  
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5.1.3 CONTROL DE VIDEOWALL 

En esta página, el usuario puede seleccionar diferentes videowalls (paredes de vídeo) y 
configuraciones que se hayan establecido en la página «Gestión de videowalls» (consulte 
el capítulo «Gestión de videowalls» para obtener más información) haciendo clic en los 
cuadros desplegables denominados «Video Wall Selection» (Selección de pared de vídeo)  
y «Configuration Selection » (Selección de configuración). 

 

 

• Encoders (Codificadores): Muestra todos los transmisores actuales. El texto de la 
figura es el nombre del dispositivo.  

• Decoders (Decodificadores): Muestra todos los receptores actuales. El texto de la 
primera línea es el nombre del decodificador, y el texto de la segunda línea se refiere 
al transmisor de donde procede el recurso de señal. 

Si arrastra los transmisores de la parte superior de la página al videowall, se 
asignarán al receptor elegido (y a la pantalla asociada en la composición del 
videowall). 
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5.1.4 PROYECTO 

Esta sección permite al usuario crear un proyecto.  

A. Current Devices )Dispositivos actuales): Dispositivos que se han añadido al 
proyecto actual.  

B. Unassigned Devices (Dispositivos no asignados): Dispositivos no añadidos al 
proyecto actual. 

 

 

1. Haga clic en «Display ID» (Mostrar ID) para visualizar el ID o PATRÓN de los 
receptores.  

2. Haga clic en «Save Project» (Guardar proyecto) para guardar el archivo del 
proyecto (config_file.json), de modo que pueda utilizar el proyecto guardado la 
próxima vez sin necesidad de volver a explorar los dispositivos. 

3. Haga clic en «Load Project» (Cargar proyecto) para cargar el archivo del proyecto 
(config_file.json) y recuperar el proyecto guardado.   

4. Haga clic en «Clear Project» (Borrar proyecto) para borrar el proyecto actual y 
volver a configurar los dispositivos.  

5. Haga clic en «Scan Once» (Explorar) para buscar dispositivos que no aparezcan 
en el proyecto actual; haga clic en «Stop Scan» (Detener exploración) para detener 
la búsqueda. 

6. Haga clic en «Start Scan & Auto Assig» (Iniciar exploración y Configuración) 
para buscar nuevos dispositivos automáticamente y añadirlos al proyecto actual. 
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5.1.5 CODIFICADORES (TRANSMISORES) 

En esta página, el usuario puede configurar el transmisor actual según sea necesario. 

A. ID: El ID del dispositivo actual. (Nota: el ID nunca se duplica) 

B. Name (Nombre): El nombre del dispositivo actual. (Nota: el nombre nunca se 
puede duplicar). 

C. MAC Address (Dirección MAC): La dirección MAC del dispositivo actual. 

D. IP Address (Dirección IP): La dirección IP del dispositivo actual. 

E. Firmware: El número de versión del firmware del dispositivo actual. 

F. Status (Estado): El estado (en línea o fuera de línea) del dispositivo actual. 

G. EDID: El EDID del dispositivo actual. 

H. Audio Selection (Selección de audio): La selección de audio del dispositivo actual 
(analógico o HDMI). 

 

 

1. Haga clic en «Refresh» (Actualizar) para actualizar los datos de los codificadores 
actuales.  

2. Haga clic en la lista desplegable de «Audio Selection» (Selección de audio) para 
establecer la salida de audio del transmisor actual.  

3. Haga clic en la lista desplegable de «EDID» para configurar el EDID del 
transmisor actual. 

4. Haga clic en el icono de flecha situado a la izquierda de la columna «ID» para 
ver el menú de gestión ampliado y comprobar la información detallada sobre el 
transmisor actual y realizar las modificaciones necesarias, tal y como se muestra 
a continuación. 
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A. Name (Nombre): El nombre del dispositivo actual. (Nota: el nombre nunca se puede 

duplicar). 
B. Update ID (Actualizar ID): El ID del dispositivo actual. (Nota: el ID nunca se duplica). 
C. Front Panel Power LED Flash )Flash LED de encendido del panel delantero): Este 

parámetro selecciona el estado de los leds del panel delantero: 
• ON (Activado): Los LED permanecen permanentemente encendidos.  
• OFF (Desactivado): Los LED tienen un tiempo de espera de 90 s, y se apagan. 

D. Power LED Flashing (El LED de encendido parpadea):  
• ON (Activado): El LED de encendido permanece parpadeando 

permanentemente.  
• OFF (Desactivado): El LED de encendido permanece inmóvil sin parpadear. 
• ON 90s (Activado durante 90 s):  El LED de encendido parpadea durante 90 s 

y luego se detiene. 
E. Encoding Bandwith (Banda de codificació)n: este parámetro ajusta la calidad de 

vídeo eligiendo el máximo de datos transmitidos para el flujo principal. 
F. Copy EDID (Copiar EDID): permite al usuario asignar un EDID externo. 
G. Serial Settings (Ajustes de serie): Este submenú permite al usuario configurar los 

ajustes para una comunicación de serie. El usuario también podrá activar o desactivar 
el «modo huésped de serie» Consulte el capítulo «Enrutamiento RS-232» para conocer 
los tipos de transmisión de comandos RS-232 en el sistema. 

H. Preview (Vista previa): Esta pantalla muestra una vista previa del contenido de vídeo 
actual del transmisor seleccionado. 

I. Reboot (Reiniciar): Este parámetro permite al usuario reiniciar el transmisor 
seleccionado. 

J. Replace (Sustituir): Permite al usuario sustituir un dispositivo desconectado por otro 
que haya sido configurado de fábrica.  

K. Remove From Project (Eliminar del proyecto): Esta opción permitirá al usuario 
desasignar el transmisor seleccionado del proyecto actual. 

L. Factory Defualt Reset (Restablecer la configuración de fábrica): Este parámetro 
permite al usuario restablecer la configuración predeterminada del transmisor 
seleccionado.  
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5.1.6 DECODIFICADORES (RECEPTORES) 

En esta página, el usuario puede configurar el receptor actual según sus necesidades. 

A. ID: El ID del dispositivo actual. (Nota: el ID no está duplicado). 

B. Name (Nombre): El nombre del dispositivo actual. (Nota: El nombre no está 
duplicado). 

C. MAC Address (Dirección MAC): La dirección MAC del dispositivo actual. 

D. IP ADdress (Dirección IP): La dirección IP del dispositivo actual. 

E. Firmware: La versión de firmware del dispositivo actual. 

F. Status (Estado): El estado (en línea o fuera de línea) del dispositivo actual. 

G. Source (Fuente): La fuente de señal (transmisor) del dispositivo actual. 

H. Scaler Resolution (Resolución del escarificador): La resolución del dispositivo 
actual. 

I. Function (Función): El modo del dispositivo actual (matriz o videowall). 

 

1. Haga clic en «Refresh» (Actualizar) para actualizar los datos de los receptores 
actuales.  

2. Haga clic en la lista desplegable de «Function» (Función) para seleccionar el 
modo de receptor actual. 

3. Haga clic en la lista desplegable de «Scaler Resolution» (Resolución del 
escarificador) para seleccionar la resolución actual del receptor. 

4. Haga clic en la lista desplegable de «Source» (Fuente) para seleccionar la fuente 
de señal del receptor actual.  

5. Haga clic en el icono de flecha situado a la izquierda de la columna «ID» para ver 
el menú de gestión ampliado y comprobar la información detallada sobre el 
receptor actual y realizar las modificaciones necesarias, tal y como se muestra a 
continuación. 
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A. Name (Nombre): El nombre del dispositivo actual. (Nota: el nombre nunca se puede 
duplicar). 

B. Update ID (Actualizar ID): El ID del dispositivo actual. (Nota: el ID nunca se duplica). 
C. Video Outupt (Salida de vídeo): Este parámetro desactiva la salida HDMI. 
D. Video Mute (Silenciar vídeo): Este parámetro muestra una pantalla negra en lugar 

del contenido real. 
E. Video Pause (Pausa de vídeo): Este parámetro congela el último fotograma 

mostrado. 
F. Video Auto On (Activación automática de vídeo): Este parámetro permite encender 

la señal de vídeo cuando se conecta un nuevo RX. 
G. Timeout After Video Lost (Tiempo de espera tras pérdida de vídeo): Este parámetro 

apagará la salida HDMI cuando no se detecte señal de vídeo después del período de 
tiempo elegido (minutos). 

H. Front Panel Buttons (Botones del panel delantero): Este parámetro permite al 
usuario activar y desactivar los botones del panel delantero. 

I. Rear Panel IR (Panel IR trasero): Este parámetro permite al usuario activar o 
desactivar el panel IR trasero. (Reservado para futuras actualizaciones). 

J. Front Panel Power LED Flash (Flash LED de encendido del panel delantero): Este 
parámetro selecciona el estado de los leds del panel delantero: 

• ON (Activado): Los LED permanecen permanentemente encendidos.  
• OFF (Desactivado): Los LED tienen un tiempo de espera de 90 s, y se apagan. 
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K. Power LED Flashing (El LED de encendido parpadea):  

• ON (Activado): El LED de encendido permanece parpadeando 
permanentemente.  

• OFF (Desactivado): El LED de encendido permanece inmóvil sin parpadear. 
• ON 90s  (Activado durante 90 s): El LED de encendido parpadea durante 90 s 

y luego se detiene. 
L. Display Product ID (Mostrar ID de producto): este parámetro muestra el ID de 

producto actual en la pantalla. 
M. Network Routing (Enrutamiento de red): permite al usuario asignar entre topología 

de red de unidifusión y multidifusión. 
N. Rotation (Rotación): Este parámetro girará la imagen de salida de 0º a 270º.   
O. Serial Settings (Ajustes de serie): Este submenú permite al usuario configurar los 

ajustes de la comunicación de serie. El usuario también podrá activar o desactivar el 
«modo huésped de serie» Consulte el capítulo «Enrutamiento RS-232» para conocer 
los tipos de transmisión de comandos RS-232 en el sistema. 

P. Preview (Vista previa): Esta pantalla muestra una vista previa del contenido de vídeo 
actual del transmisor seleccionado. 

Q. Reboot (Reiniciar): Este parámetro permite al usuario reiniciar el receptor 
seleccionado. 

R. Replace (Sustituir): Permite al usuario sustituir un dispositivo desconectado por otro 
que haya sido configurado de fábrica.  

S. Remove From Project (Eliminar del proyecto): Esta opción permitirá al usuario 
desasignar el receptor seleccionado del proyecto actual. 

T. Factory Default Reset (Restablecer la configuración de fábrica): Este parámetro 
permite al usuario restablecer la configuración predeterminada del transmisor 
seleccionado. 
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5.1.7 ENRUTAMIENTO DE SEÑALES ENLAZADAS 

En esta página, el usuario puede enrutar independientemente los diferentes tipos de 
señales entre los dispositivos transmisor y receptor (vídeo/audio, serie), lo que permite 
establecer una conexión permanente que se puede utilizar para un enrutamiento 
bloqueado para algunos dispositivos de origen determinados o un control de ampliación 
para un sistema de control de terceros.  

Cuando el cuadro desplegable muestre «FOLLOW» (SEGUIR), la señal correspondiente 
procederá del dispositivo transmisor actual. 

Por ejemplo, haga clic en el cuadro desplegable de vídeo para seleccionar una nueva 
fuente «Codificador 003» para el receptor 1, tal y como se muestra en la siguiente figura. 

Haga clic en «Locked Routing Help» (Ayuda para enrutamiento bloqueado) con el fin de 
obtener más información.  
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5.1.7.1 ENRUTAMIENTO RS-232  

El «Serial Guest Mode» (modo huésped de serie) se puede activar/desactivar en la 
página de ajustes de la web del transmisor/receptor. Consulte el capítulo «Codificadores 
(transmisores)» o el capítulo «Decodificadores (receptores)» para asignar el tipo de 
enrutamiento RS-232:  

• ON (Activado): permite enviar la conexión RS-232 de un dispositivo a través de la 
red IP (IP / comando de entrada RS-232, a comando de salida RS-232), lo que 
otorgará a los sistemas de control de terceros la capacidad de enviar un comando 
RS-232 o IP al VEO-XCTRLG2 y un comando RS-232 fuera de un receptor o 
transmisor como resultado.  

Se recomienda activar y desactivar el «modo huésped de serie» cuando sea 
necesario, ya que los comandos de serie que se envíen al VEO-XCTRLG2 se 
reenviarán a todos los dispositivos que lo tengan activado. Cuando el modo huésped 
de serie está activado, el enrutamiento de señales bloqueadas está desactivado. 

• OFF (Desactivado): un enrutamiento fijo estático para distribuir comandos RS-232 
bidireccionales entre un conjunto de transmisores y todos los receptores asociados 
que tengan configurado el enrutamiento fijo. Así, esta conexión de serie permite 
escenarios de transmisión bidireccional de serie punto a punto, punto a multipunto y 
multipunto a multipunto. 

Cuando el modo huésped de serie está desactivado, el enrutamiento de 
señales bloqueadas está activado. 
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5.1.8 GESTIÓN DE VIDEOWALL 

En esta página, el usuario puede crear y configurar videowall (pared de vídeo) según sus 
necesidades. 

• Cada receptor puede colocarse en una parte de un diseño de videowall. 

• Cada sistema puede contener varios videowalls de distintos tamaños. 

• A cada videowall se le pueden asignar diferentes pantallas y diferentes 
disposiciones que van desde 1x2 hasta 9x9. 

El controlador crea y gestiona las configuraciones de videowall y proporciona 
una interfaz de control simplificada y comandos API para el sistema de control 
de terceros. 

 

1. Haga clic en «Create»(Crear) y aparecerá una ventana emergente como la que 
se muestra a continuación. 

El usuario puede configurar el ID de videowall, el nombre y los números de 
panel horizontal y vertical.  

A continuación, haga clic en «Create»(Crear)para crear el videowall. 

 

 

Se pueden crear hasta 9 videowalls (paredes de vídeo). 
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2. Seleccione el videowall que desea configurar en la « Video Wall List» (Lista de 
videowall ) y, a continuación, haga clic en « Assign Decoder» (Asignar 
decodificador) para acceder a la página de asignación de receptores. 

 

 

3. Haga clic en cada pantalla para seleccionar el dispositivo receptor 
correspondiente y, a continuación, haga clic en «Apply» (Aplicar). 

 

 

Un receptor sólo puede asignarse a un viedowall. 
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4. Haga clic en « Class Configuration» (Configuración de tipo) para entrar en la 
página de configuración de tipo; a continuación, haga clic en cada pantalla para 
seleccionar la clase correspondiente según sea necesario (el mismo nombre de 
clase formará un videowall; puede crear un videowall regular o irregular mediante 
la configuración de clase). A continuación, haga clic en «Apply» (Aplicar). 

 

 

 

Se pueden establecer hasta 7 configuraciones para distintos escenarios de 
aplicación. 
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5.1.9 USUARIOS  

En esta página se pueden añadir nuevas cuentas de usuario. La interfaz gráfica de usuario 
de la web del controlador puede configurarse con diferentes usuarios, cada uno con sus 
propios privilegios de control, lo que permitirá al usuario crear un inicio de sesión único y 
una configuración de funciones, como entradas y salidas, a las que cada persona tendrá 
acceso.  

 

 

1. Haga clic en «New User» (Nuevo usuario) para crear un nuevo usuario. 

 

2. Haga clic en «More» (Más) para gestionar los privilegios de acceso de los usuarios. 
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5.1.10 AJUSTES DEL CONTROLADOR 

En esta página, el usuario puede configurar la comunicación y los ajustes de red para las 
redes LAN de control y vídeo según sea necesario. 

 

 

1. General Settings (Ajustes generales): Esta sección muestra un resumen de los 
ajustes básicos del VEO-XCTRLG2. Los parámetros de comunicación como 
control IR, Telnet, puerto Telnet, SSH, puerto SSH, acceso a la página, HTTPS o 
velocidad de transmisión RS-232 pueden configurarse haciendo clic en el botón 
«Actualizar». 
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2. Domain Name (Nombre de dominio): permite al usuario cambiar la etiqueta de 
dominio que se puede utilizar en lugar de la dirección IP real para entrar en la 
interfaz gráfica de usuario de la web simplemente haciendo clic en el botón 
«Actualizar» e introduciendo el nuevo nombre. 

 

3. Control Network (Red de control): Esta sección permite al usuario establecer la 
configuración de red y los parámetros DHCP para el puerto «LAN de control» del 
VEO-XCTRLG2. 

 

4. Video Network (Red de vídeo): Esta sección permite al usuario establecer la 
configuración de red para el puerto «LAN de vídeo» del VEO-XCTRLG2.  
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5.1.10.1 LISTA DE COMANDOS 

Para hacer uso de TCP de control remoto de terceros, es necesario introducir la 
dirección IP actual de VEO-XCTRLG2 y el puerto TELNET configurado para acceder al 
dispositivo. 

Es importante añadir caracteres de retorno de carro (<CR>,\r,0x0D) y de salto de línea 
(<LF>,\n,0x0A) al final de cada comando: 

Código de 
comando 

Descripción 
Comando de 

retorno 

OUT xxx FR yyy 
 

RESPUESTA 
Establecer la conexión del ID de RX xxx con el ID de TX yyy 

DESCRIPCIÓN DE PARÁMETROS 
• xxx: Número de ID de RX, entre 1 y 762 
• yyy: Número de ID de TX, entre 1 y 762 

Establecer 
SALIDA xxx 

Desde 
ENTRADA:yyy 

OUT xxx ID yyy 
 

RESPUESTA 
Cambiar el ID de RX de xxx a yyy 

DESCRIPCIÓN DE PARÁMETROS 
• xxx: Número de ID de RX antes del cambio, entre 1 y 762 
• yyy: Número de ID de RX después del cambio, entre 1 y 762.  
• Nota: Cambiar sólo el número de ID de RX, no la dirección IP. 

Establecer ID de 
SALIDA xxx 

como yyy 

OUT xxx SL yyy 

RESPUESTA 
Establecer la ESCALA yyy para el ID de RX xxx  

DESCRIPCIÓN DE PARÁMETROS 
• xxx: El número de ID de RX que se va a configurar, entre 1 y 

762  
• yyy: Número de modo ESCALA, rango 
• 0~19,0:Pass Through (por defecto); 

1: HDMI 1080p@60Hz; 
2: HDMI 1080p@50Hz; 
3: HDMI 1080p@30Hz; 
4: HDMI 1080p@25Hz; 
5: HDMI 1080p@24Hz; 
6: HDMI 720p@60Hz; 
7 : HDMI 720p@50Hz; 
8: HDMI 576p@50Hz; 
9: HDMI 480p@60Hz; 
10: HDMI 640x480@60Hz; 
11: HDMI 800x600@60Hz; 
12: HDMI 1024x768@60Hz; 
13: HDMI 1280x800@60Hz; 
14: HDMI 1280x1024@60Hz; 
15: HDMI 1366x768@60Hz; 
16: HDMI 1440x900@60Hz; 

Establecer 
SCALE de 

SALIDA xxx 
como yyy 
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17: HDMI 1600x1200@60Hz; 
18: HDMI 1680x1050@60Hz; 
19: HDMI 1920x1200@60Hz. 

OUT xxx PM yyy 

RESPUESTA 
Establecer para el ID de RX xxx el número de ID máximo de TX 

que se permite conectar 

DESCRIPCIÓN DE PARÁMETROS 
• xxx: El número de ID de RX que se va a configurar 
• yyy: Establecer el número de ID máximo que RX puede 

conectar a TX, entre 0 y 762. Cuando yyy es 0, significa que 
el TX con ID 1~762 puede conectarse; Cuando yyy es 
1~762, significa que el TX con ID 1~yyy puede conectarse. 

Establecer 
PERMISO de 
SALIDA xxx 

como yyy 

IN xxx ID yyy 

RESPUESTA 
Cambiar el ID de TX de xxx a yyy 

DESCRIPCIÓN DE PARÁMETROS 
• xxx: Número de ID de TX antes del cambio, entre 1 y 762;  
• yyy: Número de ID de TX después del cambio, entre 1 y 762.  
• Nota: Cambiar sólo el número de ID de TX, no la dirección IP. 

Establecer ID de 
ENTRADA xxx 

como yyy 

IN xxx EDID yyy 

RESPUESTA 
Establecer el EDID del ID de TX xxx como yyy 

DESCRIPCIÓN DE PARÁMETROS 
• xxx: El número de ID de TX que se va a configurar, rango 

1~762  
• yyy: Número de serie EDID, rango 0~7,  
• 0: HDMI 1080p@60Hz, Audio 2CH PCM (por defecto); 
• 1: HDMI 720p@60Hz, Audio 2CH PCM; 
• 2: DVI 1280x1024@60Hz, Audio Ninguno; 
• 3: DVI 1920x1080@60Hz, Audio Ninguno; 
• 4: DVI 1920x1200@60Hz, Audio Ninguno; 
• 5: HDMI 1920x1200@60Hz, Audio 2CH PCM; 
• 6: EDID de usuario 1; 
• 7: EDID de usuario 2 

Establecer EDID 
de ENTRADA 
xxx como yyy 

MAC GET 

RESPUESTA 
Obtener dirección MAC 

DESCRIPCIÓN DE PARÁMETROS 

• Obtener la dirección MAC del dispositivo actual 

Obtener MAC 
xx:xx:xx:xx:xx:xx 
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5.1.11 ACTUALIZACIÓN DE FIRMWARE 

En esta página,el usuario puede actualizar por separado el firmware de cualquier 
transmisor/receptor haciendo clic en el botón «Update» (Actualizar) correspondiente 
situado a la derecha o actualizar simultáneamente el firmware de todos los 
transmisores/receptores haciendo clic en el botón «Update All» (Actualizar todos) 
correspondiente.  

También existe la posibilidad de actualizar el firmware del chip Second Stream haciendo 
clic en el botón « Update SS Firmware» (Actualizar firmware de SS). 

Para actualizar por separado el firmware de cualquier transmisor/receptor: 

 

 

1. El firmware de los transmisores/receptores puede actualizarse uno a uno 
haciendo clic en el botón «Update» (Actualizar) situado a la derecha de cada 
transmisor/receptor; 

2. El firmware de todos los transmisores/receptores puede actualizarse 
simultáneamente haciendo clic en el botón «Update All» (Actualizar todos) del 
transmisor/receptor. 
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5.1.12 ACTUALIZACIÓN DE LA CONTRASEÑA 

En esta página puede cambiar la contraseña.  

Tenga en cuenta que después de cambiar, saltará automáticamente a la página de 
inicio del navegador web o a la interfaz de inicio de sesión de la interfaz gráfica de usuario 
de la web. Deberá volver a iniciar sesión en la interfaz gráfica de usuario de la web con 
la nueva contraseña. 

 

 

 

 

5.1.13 FINALIZAR SESIÓN 

Este parámetro  permitirá al usuario salir de la interfaz de la interfaz gráfica de usuario 
de la web. 
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6. FUNCIONES DE LOS PANELES 

6.1 PANEL DELANTERO 

 
1. Botón de RESTABLECER: Mantenga pulsado este botón (unos 10 segundos) hasta 

que el LED de estado empiece a parpadear: el controlador se restablecerá 
automáticamente. 

2. LED DE ENCENDIDO: El LED rojo se encenderá cuando el controlador esté activado. 
3. LED DE ESTADO: El LED de estado parpadeará en amarillo-verde cada 1 segundo 

hasta que se complete el arranque del controlador y la LAN de control esté lista; 
entonces, se volverá verde fijo. 

6.2 PANEL TRASERO 

 

1. 12 V de CC:  Puerto de entrada de alimentación de 12 V/1 A de CC. 
2. LAN DE VÍDEO (POE): Puerto LAN de vídeo de 100 Mbps, compatible con la función 

POE. 

Cuando la POE está activada, no se requiere alimentación de 12 V/1 A de CC. 

3. LAN DE CONTROL: Puerto de control de LAN de 100 Mbps. 
4. Interruptor DIP de la MCU/NORMAL: 

• Modo normal (predeterminado): El puerto RS-232 se utiliza para el control de 
comandos del puerto de serie. 

• Modo MCU: El puerto RS-232 se utiliza para actualizar el software de la MCU. 
5. Puerto RS-232: Puerto de comunicación de serie 
6. Puerto GPIO: 4 canales de salidas de nivel de E/S, 1 canal de toma de tierra, 1 canal 

de alimentación al exterior. (Reservado para futuras actualizaciones). 
7. Interruptor DE NIVEL DE E/S: Se utiliza para controlar la salida de nivel de E/S y la 

tensión VOUT. (Reservado para futuras actualizaciones). 
• Cambia a la izquierda: salida de nivel de E/S de 5 V, VOUT es de 5 V 
• Cambia a la derecha: salida de nivel de E/S de 12 V, VOUT es de 12 V. 

8. Entrada IR: Puerto de entrada IR de 12 V. (Reservado para futuras actualizaciones).  
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7. INFORMACIÓN TÉCNICA 

7.1 ESPECIFICACIONES TÉCNICAS 

VEO-XCTRLG2  

DEVICE CONTROL  
Control Connectors RJ-45, Euroblock, Jack 3.5mm 

Control Protocols Web, TCP, RS-232 
Status Indicators Power LED (Red), Status LED (Green) 

PASS-THROUGH CONTROL  
Pass-through Connectors Euroblock, Jack 3.5mm 

Pass-through Protocols RS-232 
NETWORK  

Network Connectors 2 x RJ-45  
Network Requirements IGMP Snooping 

Average Streaming Bitrate Configurable via software 1-20 Mbps 
Transmission Distance 100m via Ethernet 

ELECTRICAL  
Power Supply PoE (802.3af Class 3) or External Power supply 

AC Mains Connector 100-240VAC  50-60Hz with EU, UK, US, AU blades 
DC Mains Connector 12VDC-1A with coaxial DC connector 
Power Consumption 4.5 W 

PHYSICAL  
Operating Temperature Min: 0°C; 32°F 

Max: 40°C; 104°F 
Operating Humidity <90% HR 
Installation Options Desktop, 19" racks (1/2RU), VEO-RACK19 

Included Accessories ▪ 2x 3pins Euroblock connector 
▪ 4x M3 screws 4mm 
▪ 2x Mounting Ears 
▪ 1x 12V PSU 

Optional Accessories VEO-RACK19 
Dimensions (W x H x D) 204 × 21.5 x 98,5 mm (8.03 x 0.85 x 3.88 in. 

Shipping Dimensions (W x H x D) 257 x 78 x 159 mm / 10.12 x 30.07 x 6.26 in. 
Weight 0.540 Kg. / 1.19 lb 

Shipping Weight 0.95 Kg / 0.21 lb 
Chassis Material Metal 
Finished Colour Black 
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7.2 DIAGRAMA MECÁNICO 
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Todas las características del producto están sujetas a variación debido a las tolerancias de producción. 
NEEC AUDIO BARCELONA S.L. se reserva el derecho de realizar cambios o mejoras en el diseño o 
fabricación que puedan afectar las especificaciones de este producto. 

Para consultas técnicas diríjase a su proveedor, distribuidor o complete el formulario de contacto en nuestro 
sitio web, en Soporte / Consulta técnica. 

Motors, 166‐168 08038 Barcelona ‐ España ‐ (+34) 932238403 | information@ecler.com | www.ecler.com 

 

https://www.ecler.com/es/soporte/consulta-tecnica.html
mailto:information@ecler.com
http://www.ecler.com/

